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Steps and directions are adapted from the UCF College of Graduate Studies’ Microsoft Word Formatting
Modules.

Step 1: Page Numbers, Margins and Orientation

This PDF explains Step 1 of the step-by-step instructions that will help you correctly format your
ETD to meet UCF formatting requirements.

Step 1 shows you how to set page numbers, margins, and change the page orientation.
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Showing Document Formatting (PLEASE READ THIS FIRST!)

e Turn on the “Show/Hide All” function in Word. This will allow you to see the “hidden”
formatting of your document. There should be an icon on the ribbon that looks like this:

il (this is necessary for the next few steps, but also helpful for the rest of your
formatting)
e Clickon it.

Now that the formatting is visible, scroll to the last page before CHAPTER ONE starts. This is
where you will need to break up the document into two sections.

Page Numbers

About Page Numbering

Your ETD will need to have two sections. The first section, which includes all front matter,
receives lowercase Roman numerals. The second section, which includes all content from
CHAPTER ONE on, receives Arabic numbering. This guide will give you the steps to insert breaks,
which will allow you to switch between numbering styles.

Inserting Breaks

There are two types of breaks, page breaks and section breaks. To change page numbering, you
will need to create a section break.

e Place your cursor after the last major section before CHAPTER ONE (This may be LIST OF
ACRONYMS, LIST OF TABLES, sometimes TABLE OF CONTENTS)

e Press Enter once to start a new paragraph mark on a new line. Then go to the Layout
tab and select Break.
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A drop-down menu will appear. You want to insert a Section Break (in this case, Next Page)
here in order to break the document into two parts. This will enable you to switch from Roman
numerals to Arabic numbers.

e Select Next Page from the drop-down menu.
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Page Breaks
Page
Mark the point at which one page ends and
the next page begins.
— - Column
=|=| Indicate that the text following the column break
| will begin in the next column.

— 1T
=] Insert a section break and start the new section
on the next page.

-~ Continuous
»—— | Insert a section break and start the new section

~—=| on the same page. _

~_ Even Page
[22°| |nsert a section break and start the new section
[Z8-1 on the next even-numbered page.

___ 0Odd Page
== Insert a section break and start the new section
=37 on the next odd-numbered page.




You should see a double-line beneath your last line of text with the words “Section Break.”

LIST-OF ACRONYMS/ABBREVIATIONST

o

ACRONYM —=  — —+ —+ Definition-ofacronym T
s

ACROYNM — — —+ —+ Definition-ofacronym T

§ | 8 A A

All of your other content has shifted to the next page. Now would be a good time to erase any
extra paragraph marks that have moved to the next page (if any).

Inserting Page Numbers

UCF requires that all page numbers appear approximately 1” from the bottom of the page,
centered, without any additional formatting. This should automatically format when you insert
your page numbers.

Now place your cursor on any of the pages BEFORE the section break. You will need to change
the page numbers of your first section to lowercase Roman numerals.

e Go to the Document Elements tab and select Page # from the Header and Footer
section. A menu will appear.

e Set your position to Bottom of page (Footer) and set your alignment to Center.
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ACROYNM Definition of acronym

Position:
| Bottom of page (Footer) 3|

Alignment:

(") Show number on first page

e C(Click the Format tab. Under Number format, select lower case Roman numerals. Have
the page numbering start at i.

Number format:

"] Include chapter number

Chapter starts with style | Heading 1 :
Use separator: - (hyphen) .

Examples: 1-1, 1-A

Page numbering

() Continue from previous section

Rl -

[ Cancel ] M
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Page Numbers

Position:

Alignment:

| Center

| Bottom of page (Footer)

Show number on first page

Format...

Preview

e You want to make sure that Roman numeral i is inserted, but does NOT show on the first
page. To achieve this, make sure that you uncheck the box next to “Show number on

first page”.

e Then hit OK. Scroll up a few pages to be sure that the pages are all numbered with
lowercase Roman numerals — except the first page.

Now you will need to format the remainder of your thesis (starting from the first page of your
Chapter 1, Introduction, etc.) to follow Arabic numbering.

e You will likely notice that there is already a page number on the first page of your actual
thesis (Chapter 1, Introduction, etc.). This will likely show as page 4, 5, 6, 7, 8, etc. This
number is showing because it is continuing from your previous front-matter section.
You need to format this page number to restart at 1.

e As before, click on Page # under the Document Elements tab. The same menu will
appear that you used to format the page numbering in your front matter. Again, make
sure that you position the number on the bottom of the page and that you align the

number in the center of the page.

e From the menu, click Format

Last Updated: 10/2014



Page Number Format

umber format: [ e s
|| Include chapter number L
Posil Chapter starts with style | Heading 1

Use separator:

Align
Examples: 1-1, 1-A
Cel
Page numbering
il -:- Continue from previous section

| Cancel | [ OK ]

e Be sure that your Number format says 1, 2, 3, ... If it does not, click the down arrow and choose
it from the list.

e Also, click the radio button next to “Start at:” and choose 1.
e Then hit OK.

e Scroll down a few pages to be sure that the pages are consecutively numbered from 1
onward for the remainder of your thesis.

If they are not consecutively numbered after the first page of, look for the presence of more

section breaks in the rest of your document. Multiple section breaks can mess up pagination
throughout the document.

Margins and Spacing

About Margins

UCF recommends the following margins for your ETD:
e Left, right and bottom margins set to 1”

e Consistent top margin set to 1.5”
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Setting Margins
e Go into the Layout tab.

e Select Margins from the ribbon, then choose Custom Margins

T rome | Layour | uvocumentt
Page Setup
LN _;lo—bl -Y B -
v
Last Custom Setting u:U
Top: 1" Bottom: 1" RITrgfrE 1
Left: 1" Right: 1" :
Normal
Top: 1" Bottom: 1" B
Left: 1" Right: 1"
Narrow
Top: 0.5" Bottom: 0.5"
Left: 0.5" Right: 0.5"
Moderate
Top: 1" Bottom: 1"
Left: 0.75" Right: 0.75"
Wide
Top: 1" Bottom: 1"
Left: 2" Right: 2"
Mirrored
Top: 1" Bottom: 1"
Left: 1.25" Right: 1"
Office 2003 Default
v Top: 1" Bottom: 1"
Left: 1.25" Right: 1.25"

Custom Margins...

The Page Setup menu will appear on screen. There are two main sections you need to look at:
Margins and Preview. If your margins are set up to measure in points rather than inches,
conversion amounts are provided.

e In the margins section, change the top margin to 1.5.

e Typein or use the up and down arrows to adjust the top margin to 1.5,” and similarly
modify the left, right and bottom margins to 1”.
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- Document -
-
Varans TR
Top: 1.5" [ Preview
Bottom: 1" |=]
Left: 1" (2]
;
Gutter: 0* IEI |
- This section
From edge This point forward
_ LY v Whole document |
Header: |0.5" 5]
Footer: |0.5" a
"] Mirror margins
| Default... | | Page Setup... | | Cancel | [ OK

Once you have established the top margin, you must apply it.

Under the section labeled Preview, you will see a small menu.
e Under “Apply to...” you can click on a drop down menu. This will bring up a few options.
e Your default setting will probably be for “This section.” Select “Whole Document.”

e Hit OK.

About Spacing

UCF requires that body text be double-spaced, regardless of font choice.

All headings and subheadings, including main chapter titles, should be single-spaced (see the
help file “Headings and Subheadings” to read more about how to modify Heading spacing).

Figures, tables and their captions can be either double-spaced or single-spaced, as long as they

are done consistently for all tables/figures (see the help file “Captions” to read more about how
to modify caption spacing).
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If any of these spacing rules create a widow or orphan line in the text, inserting a hard return is
acceptable on a case-by-case basis to keep at least two lines of text together.

Orientation

About Page Orientation

Most figures and tables will be able to fit on a portrait-oriented page. However, if you do need
to change the orientation of your page to accommodate a large table or figure, use this help file
to follow the steps correctly.

Switching Between Portrait and Landscape Pages

Find the table that needs the longer page. In order to ensure that your table stays together on
the page:

e C(lick on the Table Layout tab. Under this tab, click on Properties. A menu will appear
that allows you to format your table.

# Home | Layout | Document Elements | Tables J Table Layout
2 Rows & Columns g Marge

B T B o R

Above Below Left Right Merge  Split Cells

e == ;&% fHosrbuterows | [=]. AS. [

Table Properties

i [FFT Row | Column | Cell | AltText | E
Size
| preferred width: g~ : Measure in: | Inches
Alignment
EE EH E Indent from left
= = = |3|
Left Center Right
= =
Text wrapping
None Around Positioning...
| Borders and Shading... | | Options... |
[Cance |
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e Under Alignment, choose “Left”
e Under Text Wrapping, choose “None”
e Hit OK when you’re finished.

This will keep your table from splitting while you work.

Now scroll up to the page before the table. Place your cursor on the bottom of that page and

insert a Next Page Section Break.

e With your cursor on the blank line, click on the Layout tab and select Break.
e From the drop-down menu that appears, choose Next Page (Section Breaks).

Page Setup : i
«;:8' II:_" s 2 , Top: 1 E] Bottom: 1 E{ A=, éE:E] Line
h_» Il : — ==t =
: ke Al niake. | [a]: ™
Orientation ~ Size e e A ‘umns be HyP
— | Page Breaks _—
) ‘  Page Do 2o
== N—J Mark the point at which one page ends and o '
I | the next page begins.
- Column
~|=| Indicate that the text following the column break
| will begin in the next column.
Section Breaks
(= Next Page
) Insert a section break and start the new section
on the next page.
Continuous
»—=| Insert a section break and start the new section
—| on the same page. _

_ Even Page
=2°| Insert a section break and start the new section
| on the next even-numbered page.
‘ Odd Page
“1°1 Insert a section break and start the new section
=371 on the next odd-numbered page.

DS 1)
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When you have inserted your Next Page Section Break, your page should look as follows:

]

2

Table-2:+
Number ol Kindergartens Surveyed by-State T
H UTH NYH FLHE ALH RIE CAH
1/30H 131 15H 218 35H 185 14H
2/26H 220 28 181 34H 18K 10H

This will start your new section on a new page of the document.

Follow these same steps (Layout>Break>Next Page (Section Breaks)) on a blank line after the
table. Your table should now be the only thing on this page.

*Note: Aside from page numbering and page orientation, breaks are rarely used when
formatting your thesis or dissertation. You may need to also use these when you insert
images, but do not excessively use breaks in your thesis — it will only complicate the
formatting process. If you have inserted other breaks and find the formatting to be
difficult, place your cursor next to the break and press Delete.

Put your cursor on the page containing the table. It can be in the table or outside of it, but it
must be on the same page. This is where you will change the page orientation.

e Choose the tab labeled Layout and select Orientation.

e A drop-down menu will appear. Choose Landscape.
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‘ Landscape

Your table’s page orientation will change to landscape:

—Section Break (Next Page) ——

T

Table 2:+
Numbtr-n[-lﬂndergan:ens-Smeyed-by-Stanl'ﬂ

H UTH NYH FLH ALH RIF CAE H
1/308 13H 15H 214 3sH 18t 140 H
2/260 220 28t 18t 34 18t wH H

T
o

Section Break (Next Pagi

Updating Page Numbers After Orientation Change
Following the insertion of page breaks, you will need to update the page numbers since Word
will see the new section as a brand new page 1. To update your page numbers, keep your

cursor on the page with the table.

e Go to Document Elements and select Page #.
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Page Numbers

Position: Preview

)

[ Bottom of page (Footer)

Alignment:

[ Center

EI Show number on first page

[ Cancel ] E

e Click on Format. Click on the radio button next to “Continue from previous section”.
This will keep your page numbers in sequential order.

1

by St ~__ Page Number Format {
. e (Foot
Number format: [ 1,23 . : J
— | Include chapter number
Chapter starts with style Heading 1
on fi

Use separator: - (hyphen) =
Examples: 1-1, 1-A

Page numbering

@ Continue from previous section

() start av: |:| @

[ Cancel ] [ OK ]

Now place your cursor on the page after the table. If you see this page has not updated, follow
the same steps (Document Elements>Page #>Format>Continue from previous section) to
continue the page numbering system in sequence throughout your thesis.

You are now ready for

Step 2: Headings and Subheadings
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